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About This Guide

This Arbortext IsoView User's Reference provides the information you need to use
Arbortext IsoView; a compact, distributable viewer that enables you, your
colleagues, or your customers to interactively view, manipulate, and annotate
content in technical illustration files.
Arbortext IsoView enables you to easily publish 2D and 3D illustrations and
animations to multiple media formats in an interactive environment that can be
integrated with external authoring and publishing applications.

Prerequisite Knowledge
The prerequisite knowledge you need to use Arbortext IsoView depends on how
you will use it: as a reader, an illustrator, or a developer.
•

Reader: If you will be running an application that launches Arbortext IsoView
automatically, this guide has all you’ll need to know in order to view and
interact with technical graphics in the Arbortext IsoView window.

•

Illustrator: If you plan to prepare drawings and animations for viewing in
Arbortext IsoView, you will need a basic knowledge of Arbortext IsoDraw in
addition to the instructions in this guide. See the documentation in the
Arbortext IsoDraw Help Center. (Run Arbortext IsoDraw, then choose Help ▶
Help Center .)

•

Developer: If you plan to customize Arbortext IsoView (via the
Arbortext IsoView application programming interface) to work, for example, as
an embedded viewer in a third-party application, you will need the same
knowledge as an illustrator (see above), plus, some experience programming
simple object-oriented/event-driven scripts in languages such as JavaScript or
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VBScript. (See the Arbortext IsoView Programmer's Reference, also available
in the Arbortext IsoDraw Help Center.)

Organization of This Guide
Each section of this Arbortext IsoView User's Reference is summarized below.
Section
Description
About Arbortext IsoView on page 11
Describes what Arbortext IsoView is
and what tasks you can perform with it.
It also lists which file types can viewed
in Arbortext IsoView and which
graphics standards it supports.
The Arbortext IsoView Window on
Familiarizes you with toolbar button
page 15
functions in the Arbortext IsoView
window.
Advanced Viewing Tasks on page 25
Provides instructions for tasks you can
perform in Arbortext IsoView beyond
simply viewing graphics and
animations.
Arbortext IsoView Preferences on page Describes preference settings in the
Arbortext IsoView Preferences dialog
33
box.

Related Documentation
For more information on Arbortext IsoView and Arbortext IsoDraw products, refer
to the following documentation found in the Arbortext IsoDraw Help Center. Help
Center includes both HTML and PDF versions of the documentation. Choose Help
▶ Help Center to access it.
For Arbortext IsoView information:
Documentation
Arbortext IsoView Release Notes

Arbortext IsoView Installation Guide
Arbortext IsoView User's Reference

Arbortext IsoView Programmer's
Reference
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Description
Information about new, changed, and
deleted features in this
Arbortext IsoView release.
Installation and licensing information
for Arbortext IsoView.
(This guide) Instructions for using the
tools and functions in
Arbortext IsoView, and for setting
preferences.
Reference for writing API scripts that
customize and extend the
Arbortext IsoView ActiveX control.
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For Arbortext IsoDraw information:
Documentation
Arbortext IsoDraw Release Notes

Installing Arbortext IsoDraw
Drawing Basics Tutorial
3D Mode Tutorial

Arbortext IsoDraw User's Reference

Arbortext IsoDraw Macro Language
Reference
Arbortext IsoDraw Data Exchange
Reference

Description
Information about new, changed, and
deleted features in this
Arbortext IsoDraw release.
Installation and licensing information
for Arbortext IsoDraw.
Hands-on examples for learning
Arbortext IsoDraw basic functions.
Hands-on examples for learning 3D
CAD data editing functions using
Arbortext IsoDraw.
Comprehensive guide to using the tools
and functions in Arbortext IsoDraw
products.
Reference for writing macros that you
can run in Arbortext IsoDraw.
Instructions for importing and
exporting graphics data in various
formats to and from Arbortext IsoDraw.

Technical Support
Contact PTC Technical Support via the PTC Web site, phone, fax, or e-mail if you
encounter problems using your product or the product documentation.
For complete details, refer to Contacting Technical Support in the PTC Customer
Service Guide. This guide can be found under the Related Resources section of the
PTC Web site at:
http://www.ptc.com/support/
The PTC Web site also provides a search facility for technical documentation of
particular interest. To access this search facility, use the URL above and select
Search the Knowledge Base.
You must have a Service Contract Number (SCN) before you can receive technical
support. If you do not have an SCN, contact PTC Maintenance Department using
the instructions found in your PTC Customer Service Guide under Contacting
Your Maintenance Support Representative.

Global Services
PTC Global Services delivers the highest quality, most efficient and most
comprehensive deployments of the PTC Product Development System including
Pro/ENGINEER, Windchill, Arbortext and Mathcad. PTC’s Implementation and

Technical Support
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Expansion solutions integrate the process consulting, technology implementation,
education and value management activities customers need to be successful.
Customers are led through Solution Design, Solution Development and Solution
Deployment phases with the continuous driving objective of maximizing value
from their investment.
Contact your PTC sales representative for more information on Global Services.

Comments
PTC welcomes your suggestions and comments on our documentation. You can
submit your feedback to the following email address:
arbortext-documentation@ptc.com
Please include the following information in your email:
•

Name

•

Company

•

Product

•

Product Version

•

Document or Online Help Topic Title

•

Level of Expertise in the Product (Beginning, Intermediate, Advanced)

•

Comments (including page numbers where applicable)

Documentation Conventions
This guide uses the following notational conventions:
•

Bold text represents exact text that appears in the program's user interface. This

includes items such as button text, menu selections, and dialog box elements.
For example,
Click OK to begin the operation.
•

A right arrow represents successive menu selections. For example,
Choose File ▶ Print to print the document.

•

Monospaced text represents code, command names, file paths, or other
text that you would type exactly as described. For example,
At the command line, type version to display version information.

•

Italicized monospaced text represents variable text that you would
type. For example,
installation-dir\custom\scripts\

•
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Italicized text represents a reference to other published material. For example,

Arbortext® IsoView® User’s Reference

If you are new to the product, refer to the Getting Started Guide for basic
interface information.

Documentation Conventions
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About Arbortext IsoView

Arbortext IsoView Functions .......................................................................................12
Installed File Locations...............................................................................................12
Compatibility and Standards Support ..........................................................................12

Arbortext IsoView is an intelligent and highly capable technical illustration file
viewer. It provides a single window in which you can view, markup, and interact
with illustration file content, including 2D vector and raster elements, 3D objects,
animations, and hotspot links.
The Arbortext IsoView viewer software is:
•

Implemented as a Microsoft ActiveX control which can be run from
Arbortext IsoDraw, or distributed for use in Internet Explorer, Visual Basic
applications, Arbortext Editor authoring software, and other ActiveXcompliant environments.

•

Compliant with industry standards, such as WebCGM 2.0, ASD S1000D, and
ATA iSpec 2200.
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Arbortext IsoView Functions
Arbortext IsoView enhances the experience of viewing technical graphics in
interactive documents that are distributed electronically, such as illustrated parts
catalogs, technical manuals, and work instructions.
The Arbortext IsoView ActiveX control enables users to do the following:
•

Track dynamic links between text and 2D or 3D animations.

•

Manage hotspots and animated events across both 2D and 3D content.

•

Support all industry standard viewing for CGM and WebCGM.

•

Display and print all major raster formats (TIFF, JPEG, PNG, BMP, PCX and
CALS Raster).

Installed File Locations
Arbortext IsoView installs in the following folder by default:

Arbortext-IsoView-install-path \Program Files\PTC
\Arbortext IsoView x.x
where x.x is the software version number. See the Arbortext IsoView Installation
Guide for software installation and licensing instructions, and for
Arbortext IsoView distribution guidelines.

Compatibility and Standards Support
In principle, the Arbortext IsoView ActiveX control may be used in all ActiveXcapable environments. It has been tested with the following third-party
applications:
•

Microsoft Internet Explorer 6.0, 7.0, 8.0

•

Microsoft Visual Basic 6.0

•

Microsoft Access 2000

When using Microsoft Internet Explorer, PTC strongly recommends version 6.0 or
newer. Older versions do not support all the navigation methods available in
Arbortext IsoView.

Viewable File Formats
Arbortext IsoView can open the following types of technical illustration files for
viewing and—if the format supports it—interaction with intelligent objects in the
file:
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•

Arbortext IsoDraw files (.iso)

•

CGM

•

ProductView files (.ol, .ed, .edz, .pvs, .pvz)

•

SVG

•

TIFF

•

JPEG

•

PNG

•

PCX

•

CALS Raster

WebCGM 2.0 and WebCGM DOM
Arbortext IsoView 7.0 and above supports WebCGM 2.0 and the WebCGM 2.0
DOM (Document Object Model).
For details regarding the WebCGM 2.0 DOM, please refer to the WebCGM 2.0
standard at: http://www.oasis-open.org/specs/index.php#webcgmv2.0, or the
WebCGM 2.0 recommendation at http://www.w3.org/Graphics/WebCGM/WG/.

Unicode Support
Arbortext IsoView can handle WebCGM and Arbortext IsoDraw files containing
Unicode characters. Thus, it is possible to store East-Asian language characters and
western characters in one file. Object identifiers, attributes, and screen tips use
Unicode as well.

About Arbortext IsoView
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The Arbortext IsoView Window

Arbortext IsoView Window Features............................................................................16
Arbortext IsoView Toolbar...........................................................................................17

The Arbortext IsoView ActiveX control runs in a single window inside a container
application, such as a Web browser or document authoring program. This section
describes the window features and briefly describes how to use each one.
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Arbortext IsoView Window Features
The ActiveX control window contains the current view of the open technical
illustration file. It also includes a toolbar for interacting with the view and
manipulating data in the file. (See Arbortext IsoView Toolbar on page 17.)

From the toolbar, you can open other components in the control’s viewing area,
including the:
•

Search dialog box (see Searching for Elements and Objects in an Illustration on
page 26

•

Magnifier window (see Using the Magnifier Window on page 28)

•

Global View window (see Using the Global View Window on page 29)

•

Preferences dialog box (see Arbortext IsoView Preferences on page 33)

•

Print , Open , and Save As dialog boxes
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About the viewing area
The viewing area in the Arbortext IsoView window displays the default or initial
view of the graphic when you open Arbortext IsoView.

Note
Some types of files enable you to specify the initial view by setting a view attribute
in the file.
You use tools on the toolbar to change the view of the graphic in the viewing area.
You can zoom in and out viewing area and pan the view in any direction. Resizing
the Arbortext IsoView `window proportionally resizes the graphic in the viewing
area.
About the toolbar
The toolbar enables you to do the following tasks:
•

Manipulate your view of the graphic.

•

Interact with intelligent objects in the graphic, such as hotspots, views, links,
and animations.

•

Add redlining information, such as lines, shapes, and text annotations, to the
graphic.

About the Preferences dialog box
You can open a Preferences dialog box from the toolbar to view and change
settings for the toolbar’s position and appearance. You can also use it to change
preference settings for other Arbortext IsoView window features, such as redlining,
annotations, the display method, and the printing method. (See Arbortext IsoView
Preferences on page 33.)

Arbortext IsoView Toolbar
When the Arbortext IsoView window opens, the toolbar appears in the bottom left
corner by default.
You can change the toolbar’s position and specify which buttons appear on it using
the Toolbar preferences in the Arbortext IsoView Preferences dialog box. Since the
toolbar is configurable through the Preferences dialog box, some toolbar buttons
might appear in the toolbar, in the vertical popup toolbar, or be unavailable. (See
Arbortext IsoView Preferences on page 33.)

The Arbortext IsoView Window
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The function of each toolbar button is summarized below.
Description
Toolbar Button Tool Tip
Moves the image in the
Pan
Arbortext IsoView window in any
direction.

Rotate

Zoom in

Select the Pan
button, then drag
the pointer in the window. The image
moves in the dragging direction.
Rotates 3D objects in the window in
any direction. (This toolbar button only
appears if the file contains 3D objects.)
Select the Rotate
button, then click
in the window and drag the pointer. The
image rotates in the dragging direction.
Increases the size of the graphic.
Select the Zoom in
button, then
click the part of the graphic that you
want to make larger. The graphic size
increases while remaining centered on
the part of the graphic that you clicked.
Each time you click in the window, the
graphic gets larger.
You can also drag a selection rectangle
around a region you want to zoom in
on. When you release the mouse button,
the region zooms to fit the entire
window.

Zoom out

Click to zoom in; SHIFT-click to zoom
out; CTRL-click to zoom inside
hotspots; Drag a selection rectangle to
zoom in on a region. (If you have a
mouse wheel, you also can roll it to
zoom in/out.)
Decreases the size of the graphic.
Select the Zoom out
button, then
click the part of the graphic that you
want to make smaller. The graphic size
decreases while remaining centered on
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Toolbar Button

Tool Tip

Show objects with
hotspots

Start animations

Stop animations

Description
the part of the graphic that you clicked.
Each time you click in the window, the
graphic gets smaller.
Click to zoom out; SHIFT-click to
zoom in; CTRL-click to zoom inside
hotspots. (If you have a mouse wheel,
you also can roll it to zoom in/out.)
Highlights hotspot objects in the
graphic.
Select the Show objects with hotspots
button; all hotspots in the image
are highlighted. The hotspots remain
highlighted while the mouse button is
pressed.
Starts animation. (This tool only
appears if the file contains animation.)
Click the Start animations
button
to start or resume an animation
sequence.
Stops animation. (This tool only
appears if the file contains animation.)

Click the Stop animations
button
to stop an animation sequence at the
current time point.
Rewind animations Rewinds the animation. (This tool only
appears if the file contains animation.)

Print

The Arbortext IsoView Window

Click the Rewind animations
button to rewind an animation sequence
to the start point (time=0 seconds).
Prints the illustration file currently open
in the Arbortext IsoView window.
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Toolbar Button

Tool Tip

Description
Select the Print
button to open the
Print dialog box and print the
illustration, or, to print the file directly
(without opening the Print dialog box).

Search

Home

Note
Changing the view of an illustration in
the Arbortext IsoView window will not
change the appearance of the printed
image. Rather, the appearance of the
printed image depends on settings in
the Print dialog box and, if supported,
print preference settings stored in the
file.
Finds elements and objects the in the
graphic based on object data you
specify in the Search dialog box.
Select the Search
button to open
the Search dialog box. (See Searching
for Elements and Objects in an
Illustration on page 26.)
Returns the graphic to its original view.
Select the Home
button to return
the graphic view to its original size and
location.

Toggle magnifier
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Note
The display of a graphic in the
Arbortext IsoView window has no
effect on how that graphic appears
when it is published. For HTML and
web publishing, either the default view
of the graphic—or an initial view
specified by a view attribute in the file
(if supported)—is used when
publishing a document.
Opens or closes the Magnifier window.
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Toolbar Button

Tool Tip

Description
Select the Toggle magnifier
button;
a small Magnifier window opens inside
the Arbortext IsoView window.

Toggle global view

(See Using the Magnifier Window on
page 28.)
Opens or closes the Global View
window.
Select the Toggle global view
button; a small Global View window
opens inside the Arbortext IsoView
window.

Toggle redlining
mode

(See Using the Global View Window
on page 29.)
Switches Redlining mode on or off.
Select the
button; all Redlining
toolbar buttons become either selectable
or not selectable—whatever state is
opposite what they were before you
clicked the button.

Draw redlining
element

(See Redlining an Illustration on page
29.)
Activates the redlining freehand
element drawing mode (only selectable
if Redlining mode is active).
Select the Draw redlining element
button; the pointer changes to a draw
redlining element pointing finger

.

With the pointer in the window:
1. Click and drag to draw a redlining
element. Release the mouse button
to finish the element.
2. Click and drag to start drawing
another element.
3. Click any other toolbar button to
exit this drawing mode.

The Arbortext IsoView Window
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Toolbar Button

Tool Tip
Draw redlining
circle

Description
Activates the redlining circle drawing
mode (only selectable if Redlining
mode is active).
Select the Draw redlining circle
button.
With the pointer in the window:
1. Click and drag to draw a redlining
circle. Release the mouse button to
stop drawing and finish the circle.
2. Click and drag to start drawing
another circle.

Draw redlining
rectangle

3. Click any other toolbar button to
exit this drawing mode.
Activates the redlining rectangle
drawing mode (only selectable if
Redlining mode is active).
Select the Draw redlining rectangle
button.
With the pointer in the window:
1. Click and drag to draw a redlining
rectangle. Release the mouse button
to stop drawing and finish the
rectangle.
2. Click and drag to start drawing
another rectangle.

3. Click any other toolbar button to
exit this drawing mode.
Draw redlining line Activates the redlining line drawing
mode (only selectable if Redlining
mode is active).
Select the Draw redlining line
button.
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Toolbar Button

Tool Tip

Description
With the pointer in the window:
1. Click and drag to draw a redlining
line. Release the mouse button to
stop drawing and finish the line.
2. Click and drag to start drawing
another line.

Add redlining
annotation

Delete redlining
annotation

Export redlining

Import redlining

Preferences

More tools

The Arbortext IsoView Window

3. Click any other toolbar button to
exit this drawing mode.
Activates the redlining annotation mode
(only selectable if Redlining mode is
active).
(See Adding redlining annotations on
page 30.)
Activates the redlining delete mode
(only selectable if Redlining mode is
active).
(See Deleting redlining information on
page 30.)
Exports the illustration and the
redlining information (only selectable if
Redlining mode is active).
(See Saving, exporting, and importing
redlining information on page 31.)
Imports redlining information (only
selectable if Redlining mode is active).
(See Saving, exporting, and importing
redlining information on page 31.)
Opens the Arbortext IsoView
Preferences dialog.
(See Arbortext IsoView Preferences on
page 33.)
Opens the vertical popup toolbar to
provide access to toolbar buttons not
shown on the horizontal toolbar.
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Toolbar Button

Tool Tip

Description
Toolbar buttons that are set to in popup
menu in the Preferences dialog box
always appear on the vertical popup
toolbar (whether they are selectable or
not).
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Advanced Viewing Tasks

Searching for Elements and Objects in an Illustration....................................................26
Using the Magnifier Window .......................................................................................28
Using the Global View Window ...................................................................................29
Redlining an Illustration ..............................................................................................29

You can do more than simply view graphics and animations in Arbortext IsoView.
Advanced viewing tasks, such as searching and redlining, are also available
through the toolbar. This section provides instructions for performing these tasks.
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Searching for Elements and Objects in an
Illustration
Select the
toolbar button to find elements or objects in the illustration based
on object data. You will be prompted to specify the search options in a Search
dialog box:

Note
The Search dialog box in Arbortext IsoView works like the Select elements dialog
box in Arbortext IsoDraw. (In Arbortext IsoDraw, choose Edit ▶ Select .) However,
in Arbortext IsoView, elements that have no object info assigned can still be found
and highlighted using Search .
To search for elements and objects using the Search dialog box:
1. Select search for .
2. Choose the type of object information to search for in the first (left) drop-down
list.
The choices are:
•

Object info

•

Object ID

•

Object name

•

Object tip

•

Object attribute

•

Text

3. In the second drop-down list, select the search criteria for the object
information you chose in the first list.
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If you chose Object attribute in the first list, a separate Search attribute dialog
box opens. In the Enter attribute name box, type the name of the attribute
whose value you want to search for, then click OK .

4. If a text box now appears on the right side of the Search dialog box, type the
value of the object information you want to find, such as a text string or
attribute value.
5. Click OK . Arbortext IsoView highlights all elements and objects that match the
search conditions in the viewing area. It also zooms the view to fit all
highlighted objects.
To remove the highlight from all elements and objects found in a previous search:
1. In the Search dialog box, select remove highlight .
2. Click OK . Highlighting is removed from all highlighted elements and objects.

Advanced Viewing Tasks

27

Using the Magnifier Window
To use the Magnifier window, select the Toggle magnifier
button; a small
Magnifier window opens inside the Arbortext IsoView window.

Click on the graphic to see a magnified view of the region surrounding the location
you clicked. Move the slider in the Magnifier window up or down to increase or
decrease the magnification.
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Using the Global View Window
Select the Toggle global view
button; a small Global View window opens
inside the Arbortext IsoView window. The Global View window contains a red
rectangle. The sides of the red rectangle correspond to the edges the
Arbortext IsoView window.

•

Drag the red rectangle in the Global View window to change how the graphic is
framed in the Arbortext IsoView window.

•

Zoom in or out in the Arbortext IsoView window to change the size of the red
framing rectangle in the Global View window.

Redlining an Illustration
The Redlining mode in Arbortext IsoView enables you to add information to an
existing illustration using the redlining tools on the toolbar. To use these redlining
tools, first start the redlining mode by selecting the Redlining
toolbar button.
All redlining tools on the toolbar become selectable.

Note
You can select the auto hide redlining tools check box in the Preferences dialog
box to hide the redlining toolbar buttons until the Redlining mode is activated.
Drawing graphical redlines
In Redlining mode, you can toolbar’s redline drawing buttons
to
draw red lines, rectangles, circles, and curves on the graphic. Once drawn, you can
drag redline elements to move them elsewhere on the window, but you cannot
change their size or shape.

Advanced Viewing Tasks
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Adding redlining annotations
If you want to add a text annotation to your graphic in redlining mode, do the
following:
1. Select the Add redlining annotation
changes to a text pointing finger

button in Redlining mode; the pointer
.

2. Click on the graphic to place the annotation. A small text editing window
opens at that location. The editing window title bar shows the user name and
date the annotation will be saved with.

3. Add or edit your annotation text in this window, then close it. The annotation
changes to an icon
at that location in the Arbortext IsoView window.
4. To view or edit the annotation text later, click the annotation icon
the annotation editing window.

to open

Deleting redlining information
There are two ways to delete redlining information (graphics or annotations):
•

With Redlining mode on or off:
1. Place the pointer over the redlining graphic or annotation icon you want to
delete.
2. When the pointer changes to a pointing finger
redlining graphic or annotation icon.

, click to select the

3. Press the DELETE key.
•
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With Redlining mode on:
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1. Select the Delete redlining annotation
pointing finger

button; the pointer changes to a

.

2. Place the pointer over the redlining graphic or annotation icon you want to
delete.
3. When the pointer changes to an eraser pointing finger
the redlining graphic or annotation icon.

, click to delete

Saving, exporting, and importing redlining information
When you close the Arbortext IsoView window, any redlining information
displayed in it is automatically saved with the graphic file, whether you are in
Redlining mode or not. The next time you open that same graphic file in
Arbortext IsoView, your redlining information will reappear.
If you want to export redlining information from a graphic file, then import it into a
different graphic file, use the Export redlining
and Import redlining
toolbar
buttons as follows:
1. If you are not in Redlining mode, select the Toggle redlining mode

button.

2. Select the Export redlining
button. The Save As dialog box opens,
prompting you to save the current graphic’s redlining information to an ISO
file with the same filename as the graphic.
3. Click Save . The redlining information is saved to a separate *_rl.iso file.
For example: If you saved the file as filename.iso, the redlining
information is saved in a separate filename_rl.iso file.
4. To import the redlining information you just exported to filename_rl.
iso, select the Import redlining
toolbar button. The Open dialog box
appears.
5. Select the Redlining file, filename_rl.iso, then click Open . The
redlining information in filename_rl.iso appears in the
Arbortext IsoView window.

Advanced Viewing Tasks
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Click the Preferences
toolbar button in the Arbortext IsoView window to
open the Arbortext IsoView Preferences dialog box below. (See Arbortext
IsoView Toolbar on page 17 to locate the Preferences toolbar button.)

You can view and change the following Arbortext IsoView window options in the
Preferences dialog box:

•

Redlining line color and line width. (See Redlining Preferences on page 35.)

•

Annotation history management and font. (See Annotation Preferences on page

35.)
•

Toolbar position, arrangement and auto-hide. (See Toolbar Preferences on page

36.)
•

Display and Printing options. (See Display and Printing Preferences on page

36.)
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Redlining Preferences
Set redlining preferences under Redlining in the Arbortext IsoView Preferences
dialog box.

Linecolor

Sets the color of the redlining drawing line. Click the colored
Linecolor box to open the Color palette dialog box and select

Line width
Automatically
delete
annotations not
accessed for
[ number ] days
Do not delete
annotations
automatically
Delete all
annotations

a line color.
Sets the line width of the redlining drawing line. Type the
width (in points) in the Line width box.
Select to automatically delete annotations after the number of
days typed in the box.

(Default) Select this option to switch off the automatic
deletion of annotations.
Click the Delete all annotations button to manually delete all
annotations in the current graphic. Click Yes to confirm
deletion or No to cancel.

Annotation Preferences
Set annotation preferences under Annotation in the Arbortext IsoView Preferences
dialog box.

Font
size
Change

Displays the typeface for text in the popup annotation text
editor window.
Displays the point size for text in the popup annotation text
editor window.
Click the Change button to open the Font dialog box and
change the font typeface and point size used for annotation
text.

Arbortext IsoView Preferences
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Toolbar Preferences
Set toolbar preferences under Toolbar in the Arbortext IsoView Preferences dialog
box.

Position

Toolbar button
settings

Select top or bottom and left or right to specify which corner
of the window the toolbar will appear in; top-left, top-right,
bottom-left, or bottom-right.
You can select one of the following states for each toolbar
button:
as button
in popup
menu
unavailable

auto hide
redlining tools

(Default) This button appears on the toolbar.
This button appears in the vertical popup
toolbar. (Select the More tools
button to
open this popup toolbar.)
This button does not appear on the toolbar or
on the vertical popup toolbar.

Select check box to hide the redlining toolbar buttons until
the Redlining mode is activated.
Clear check box to show the redlining toolbar button whether
Redlining mode is activated or not.

Display and Printing Preferences
Set display and printing preferences under Display and Printing in the
Arbortext IsoView Preferences dialog box.
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Use AntiAliasing
Use default
printer

(Default) Select check box to switch anti-aliasing on.
Clear check box to switch anti-aliasing off.
Select check box to print to the default printer without
opening the Print dialog box when the Print
toolbar
button is clicked.
(Default) Clear check box to open the Print dialog box when
the Print
toolbar button is clicked.

Arbortext IsoView Preferences
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